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1. Introduction to Kernel for SQL Database
Welcome to the User Manual for Kernel for SQL Database, an effective and powerful data recovery
software to recover data from the corrupt SQL databases (.MDF). This user manual comprises step-bystep guidelines on using Kernel for SQL Database software.

1.1 Using this Manual
This User Manual is intended to guide users on using Kernel for SQL Database. We suggest that first time
users should read this User Manual completely and carefully before proceeding to use the software.
However, if you are an experienced user, you can use the Table of Contents to find out information
pertaining to the tasks that you need to perform by using Kernel for SQL Database.
You can use the Table of Contents to navigate through different sections of this User Manual. The Table
of Contents enlists all the sections contained within this user manual in chronological order. This User
Manual comprises following sections:
Introduction
Getting Started
Software Interface
Repairing .MDF Files
Full Version
Support
Troubleshooting
Legal Notice
Certain abbreviations have been used throughout this manual. For clear understanding of the contents of
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual.

1.1.1 List of Abbreviations
MS: Microsoft
SQL: Structured Query Language
QFSCI: Quick File System Component Identification
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RAM: Random Access Memory
MB: Mega-Byte
GB: Giga-Byte

1.2 About Kernel for SQL Database
Kernel for SQL Database is an advanced and professional database recovery software that recovers data
from corrupt, damaged .MDF database files. Kernel for SQL Database software is equipped with powerful
QFSCI algorithm which efficiently scans and retrieves data from the corrupt databases.
The common reasons which lead to SQL database corruptions are:
Invalid database file header
Not able to associate database file with different databases
Internal Program Error(s)
Crash or failure of hard drive
Media contamination or damage
Accidental deletion of data and files
Accidental reformatting of partitions
Virus attacks
Data corruptions

1.3 Salient Features
Salient features of Kernel for SQL Database include:
Effectively repairs and extracts data from the corrupt SQL database (.MDF).
Creates script file(s) where the recovered files are saved.
Deleted records can be recovered and are saved in a separate SQL script.
Accurately recovers Microsoft SQL Server backup files.
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Accurately recovers all database objects contained within .MDF files including tables, triggers,
views, stored procedures, primary keys, indexes, unique keys, foreign keys, pre-defined defaults,
default values, rules, checks, and user data types (default, rule, Allow null).
Capable of restoring data on server while SQL Server is still running.
Preserves structure and properties of recovered SQL databases objects.
Recovers multiple .MDF files and folders in no matter of time.
Efficiently repairs large-sized .MDF files.
Fully supports recovery of data from .MDF files created with SQL Server version 2000, 2005, 2008,
2008 R2 and 2012.
Offers an easy-to-use, self-descriptive, user-friendly Graphical User Interface. No technical skills
required for operating the software.
Available as a free to download demo version.
Offers round-the-clock technical support.

1.4 Who Should Use this Software?
The capability of Kernel for SQL Database to repair large-sized SQL databases makes it appropriate for
use by SQL Server administrators, who need to recover data from corrupt or damaged .MDF database
files. The corruption could have been caused due to virus attacks, improper system shutdown, network
problems, database file header corruption, etc.
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2. Getting Started
Now that you have understood the features and potential of Kernel for SQL Database, you are ready to
get a hand on experience of the software. To start repairing .MDF files, you will first need to download and
install this software.
It is strongly recommended that before installing Kernel for SQL Database, you should go through the
installation pre-requisites for the software to ensure that your computer is appropriately configured to run
the software.

2.1 Installation Pre-requisites
The various pre-requisites for installing and running Kernel for SQL Database can be broadly classified
into two major categories – Hardware requirements and Software requirements.

2.1.1 Hardware Requirements
The hardware requirements for installing the software are as follows:
Pentium Class Processor
Minimum 64MB RAM (128 MB Recommended)
10MB free space for Software Installation
Disk Space - Enough disk space to save the results

2.1.2 Software Requirements
The software requirements for installing the software can further be grouped into two categories –
Operating System requirements and SQL Server version requirements. The requirements are as follows:

2.1.2.1 Operating System Requirements
Supported Windows Platforms:
Windows 8
Windows 7
Windows Vista
Windows XP

©Lepide Software Private Limited

Windows Server 2000
Windows Server 2003
Windows Server 2008
Windows Server 2008 R2
Windows Server 2012

2.1.2.2 SQL Server Version Requirements
Supported MS SQL Server Versions:
SQL Server 2000
SQL Server 2005
SQL Server 2008
SQL Server 2008 R2
SQL Server 2012

2.2 Downloading Kernel for SQL Database for the First Time
After checking your computer with the prescribed system requirements for Kernel for SQL Database, you
can download and install the software on your computer. You can buy the full version of the software from
any one of our authorized resellers – Element5, Asknet and 2CO.
If you want to try using Kernel for SQL Database before buying it, you can download the evaluation
version from the following link:
https://www.nucleustechnologies.com/download-sql-recovery.php



You can repair .MDF files saved on your system by using the evaluation version of Kernel for SQL
Database; however, the repaired file will not be saved until you purchase the full version of the
software.

2.3 Install Kernel for SQL Database
After downloading the installer file for Kernel for SQL Database, you can install the software by running the
file. To install Kernel for SQL Database:
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1. Double-click the Kernel for SQL Database installer.
2. Follow the on-screen instructions.
3. The Setup Installation Complete screen get displayed.
4. Click Finish to launch the software.

2.4 Start Kernel for SQL Database
To start Kernel for SQL Database:
Click Start  All Programs  Kernel for SQL Database
Alternatively, you can launch Kernel for SQL Database by double-clicking the shortcut icon available on
the desktop and Quick Launch icon.

2.5 Uninstall Kernel for SQL Database
You may need to uninstall and re-install Kernel for SQL Database. To uninstall Kernel for SQL Database:
1. Click Start  All Programs  Kernel for SQL Database  Uninstall Kernel for SQL Database
A warning message will be displayed.
2. Click ‘Yes’ to uninstall Kernel for SQL Database.



Before proceeding to uninstall Kernel for SQL Database, you must ensure that the
software is not running.

You can alternatively uninstall Kernel for SQL Database from the Control Panel by performing the
following steps:
1. Click the Start Menu  Control Panel and then double-click the Add or Remove Programs icon.
2. Select Kernel for SQL Database and click Remove.
A warning message will be displayed.
3. Click ‘Yes’ to uninstall Kernel for SQL Database.
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3. Software Interface
Now that Kernel for SQL Database has been installed on your computer, you can start using the software
after getting acquainted with the software interface.

3.1 Menu Bar
The Menu bar of Kernel for SQL Database comprises three menus:
File Menu
Tools Menu
Help Menu

3.1.1 File Menu
The File menu comprises three menu items:

Figure 3.1: File Menu

Following table enlists the options available in the File menu:
Option

Description

Open

Select this option to locate the damaged SQL database on your hard disk

Save

Select this option to save the data so recovered from the SQL database

Exit

Select this option to close the application

3.1.2 Tools Menu
The Tools menu comprises only one menu item:
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Figure 3.2: Tools Menu

On clicking on Options menu item, the software offers two options that are:
Option

Description

Consider all pages as corrupted

Highly-recommended to select this option; proves useful in
recovering data from heavily-corrupted databases

Save the tables without identity
property

Select this option if tables are not saving due to corrupted data.
Checking this option will allow saving the tables without
identity; you can set the identity of these tables after recovery

3.1.3 Help Menu
Help menu of Kernel for SQL Database software appears, as shown in the following figure:

Figure 3.3: Help Menu

Following table enlists the options available in the Help menu:
Option

Description

Kernel for SQL Database Help

Select this option to view Help manual of the software

Kernel for SQL Database Homepage

Select this option to visit the webpage to know more about
the software

About Kernel for SQL Database

Select this option to view version information about the
software and various other related links

3.2 Tool Bar
Tool bar consists of buttons that work as short cuts for various options available in the main menus of
Kernel for SQL Database software. Following table enlists the buttons available on the Tool bar of the
software:
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Button

Description
Select this option to locate the damaged SQL database on your hard disk

Select this option to save the data so recovered from the SQL database

Select this option to view Help manual of the software

3.3 Buttons Used
There are several buttons used in the software that helps you throughout the recovery process. Following
table enlists the buttons used in the software:
Button

Description
This option initiates the recovery process of the selected database
This option cancels the action and closes the dialog
This option lets you locate the damaged SQL database
This option takes you to the previous page in the record
This option takes you to the next page in the record
This option lets you stop the ongoing process
This option allows you to refresh the process
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4. Repairing .MDF Files
Kernel for SQL Database is an ideal software that helps you restore objects from corrupt databases. No
matter what made your MDF database corrupt or inaccessible, Kernel for SQL database will recover your
data easily and quickly. Follow the steps given below to repair SQL Databases:
1. Select Start > All Programs > Kernel for SQL Database > Kernel for SQL Database to launch the
software. The software home window appears:

Figure 4.1: Home Window of Kernel for SQL Database



"Select SQL Database" dialog appears by-default when the software is launched. This dialog
can be launched by clicking the Open button in Tool bar or by selecting File menu > Open.

2. Click the Browse button to locate the corrupt SQL Database:
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Figure 4.2: Locate Corrupt SQL Database

3. Select the SQL Database version with which the .MDF file is created:
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Figure 4.3: Select SQL Database Version

4. Click the Recover button to initiate the recovery process, Software will enlist the SQL database
objects in the left pane:
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Figure 4.4: Enlisted SQL Database Objects

Note that, if the user selects the wrong SQL Server version, software displays the following error
message:

Figure 4.5: Error Message on selection of wrong SQL Server version

5. Select an object in the left tree whose content you want to verify before saving. When you select the
folder, its content will be displayed in the right pane:
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Figure 4.6: Preview of Selected Object

6. After previewing the required items, select the data for saving and then click the Save button. The
'Saving Mode' dialog box appears:
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Figure 4.7: Available Saving Modes



To save the data, you can click the Save button on the Tool bar or go to File menu > Save

You can save the recovered objects in two different modes which are:


SQL Server: Using this option, the recovered objects can be saved on SQL Server directly, even if
the Server is running. To save the data on SQL Server:
1. Mention Server Name and Name of the database in Server Name and Database Name fields
respectively. Do not provide the name of existing database in Database Name field. Create a
new database in SQL Server Management Studio and enter the name of new database in
Database Name field. However, existing database name can also be provided but in case of
existing database restored objects will get merged with existing objects.
2. Select the Authentication option with which you wish to access the SQL Server i.e. Windows
Authentication or Server Authentication
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To access SQL Server with Server Authentication, you need to enter User Name and
Password in the respective fields.



Batch File: Using this option, you can save the batch file of the rebuilt SQL database on a desired
location. To save the recovered, you need to browse the location using the Browse button. The
data so recovered is saved in separate script files at the desired location. Also, a script file
(commit.bat) is also created that enables the user to easily copy the recovered objects to a new
database created on SQL Server. To copy recovered objects to new database on SQL server:
1. Go to SQL Server Management Studio
2. Create a New Database
3. Double-click on commit.bat
OR
(Run  cmd ) Change the path to recovered folder ( cd PathName)
4. Use following syntax:
>commit.bat servername newcreateddatabase sqlserverusername sqlserverpassword
Press Enter key and all tables will be copied to the new created database.

7. After selecting the required Saving Mode option, click OK button. The software starts saving the
recovered objects:
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Figure 4.8: Saving Database Objects in Progress

8. The software displays following 'Process Completed' dialog box when the data is saved successfully
at the desired location:
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Figure 4.9: Successful Saving of Database Objects

9. Click OK button to close the 'Process Completed' dialog box.

5. Download Purchase and Register
5.1 Free Trial Download
Kernel for SQL Database is available for free evaluation so that the users can ensure the working of the
software closely. Using free evaluation version allows you to check the features, functionality and the
accuracy of the results. The evaluation version of this software is fully functional just like the full version
but it restricts the user from saving the recovered objects. In order to save the entire data so recovered,
you need to purchase the full version of Kernel for SQL Database.
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Free version of Kernel for SQL Database can be downloaded from our
website:
https://www.nucleustechnologies.com/download-sql-recovery.php

5.2 Purchase & Register
Purchase the full version of Kernel for SQL Database software for saving the recovered objects from SQL
database .MDF files accurately. The FREE trial version of Kernel for SQL Database software allows you
to preview the recovered objects but restricts from saving them.
You can purchase the Full version of Kernel for SQL Database software through our website:
https://www.nucleustechnologies.com/buy-sql-recovery.php (encrypted and secure site).
Payment and Delivery
Purchase the Kernel for SQL Database software from our authorized resellers, which provide number of
payment options for your ease - PayPal, FAX, Credit Card, E-cheque, Pay Order, etc.
After making the purchase transaction with our resellers, an email is sent consisting of activation details
and download link of the Full version of Kernel for SQL Database comprising of the activation code. This
email is sent to the email address, which you have used while processing the purchase transaction with
our resellers.
We suggest you not to use false e-mail address while making the purchase transaction.
For any other details related to purchase process, software activation process, email us
at: sales@nucleustechnologies.com

5.3 Support
Lepide Software Pvt. Ltd. provides round-the-clock technical support for its product range to solve
technical and software queries. The software comes with an embedded help manual that can be accessed
by clicking Help in the software main window. You can also press the F1 key on the keyboard of your
computer to access the embedded help manual of Kernel for SQL Database.
You
can
access
the
online
help
for
at: https://www.nucleustechnologies.com/Online-Helps.html
We also have live support wherein you
at: https://www.nucleustechnologies.com/supportcenter/
Telephone Support:
+91-9818725861
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can

Kernel

chat

with

for

our

SQL

software

Database

experts

1-866-348-7872 (Toll Free for USA/CANADA)
Email Support:

sales@nucleustechnologies.com for Sales
support@nucleustechnologies.com for Support
contact@nucleustechnologies.com for General Queries
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6. Troubleshooting
6.1

Common Issues

What is the limitation in the trial version of Kernel for SQL Database?
The trial version of Kernel for SQL Database works almost same as that of the full version of the software
such that it accurately recovers entire database objects embedded within the SQL Server database .MDF
files, displays preview of all the recovered objects but restricts users from saving them. In order to save
the entire recovered SQL database objects, user must purchase the full licensed version of the software.

6.2

Frequently Asked Questions

1. How to purchase Kernel for SQL Database?
One can buy Kernel for SQL Database using the website:
www.nucleustechnologies.com/buy-sql-recovery.php
2. What are the two different options offered by Kernel for SQL Database?
The two options offered by Kernel for SQL Database are - Consider all pages as corrupted, and Save
the tables without identity property.
3. What are the supported Windows OS platforms for Kernel for SQL Database software?
The supported Windows OS platforms for Kernel for SQL Database software are: Windows 8, Windows 7,
Windows Vista, Windows XP, Windows Server 2000, Windows Server 2003, Windows Server 2008,
Windows Server 2008 R2, and Windows Server 2012.
4. What are the supported MS SQL Server versions for Kernel for SQL Database software?
The supported MS SQL Server versions for Kernel for SQL Database software are: SQL Server
2000, SQL Server 2005, SQL Server 2008, SQL Server 2008 R2, and SQL Server 2012.
5. Give the link for downloading the free trial version of Kernel for SQL Database software.
The free trial version of Kernel for SQL Database software can be downloaded using the link:
www.nucleustechnologies.com/download-sql-recovery.php
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7. Legal Notices
This section comprises the legal specification about Kernel for SQL Database and the company Lepide
Software Private Limited.

7.1 Copyright Notice
Lepide Software Private Limited, Kernel for SQL Database, accompanied user manual, and
documentation are copyright of Lepide Software, with all rights reserved. Under the copyright laws, this
user manual cannot be reproduced in any form without the prior written permission of Lepide Software.
No Patent Liability is assumed, however, with respect to the use of the information contained herein.
© LEPIDE SOFTWARE PVT LTD. All rights reserved.

7.2 Trademarks
Kernel for SQL Database ® is a copyright work of Lepide Software Private Limited.
Windows 8®, Windows 7®, Windows Vista®, Windows XP®, Windows Server 2000®, Windows Server
2003®, Windows Server 2008®, Windows Server 2008 R2®, and Windows Server 2012® are registered
trademarks of Microsoft Corporation.
All other brand and product names are trademarks or registered trademarks of their respective
companies.

7.3 Disclaimer
The information contained in this manual, including but not limited to any product specifications, is subject
to change without notice. Lepide Software Private Limited provides no warranty with regard to this manual
or any other information contained herein and hereby expressly disclaims any implied warranties of
merchantability or fitness for any particular purpose with regard to any of the foregoing. Lepide Software
Private Limited assumes no liability for any damages incurred directly or indirectly from any technical or
typographical errors or omissions contained herein or for discrepancies between the product and the
manual.
In no event shall Lepide Software Private Limited be liable for any incidental, consequential special, or
exemplary damages, whether based on tort, contract or otherwise, arising out of or in connection with this
manual or any other information contained herein or the use there of.

7.4 License Agreement
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Kernel for SQL Database © by Lepide Software Private Limited.
Your Agreement to this License
You should carefully read the following terms and conditions before using, installing, or distributing this
software, unless you have a different license agreement signed by Lepide Software Private Limited. The
terms and conditions of this License describe the permitted use and users of each Licensed Copy of
Kernel for SQL Database. For purposes of this License, if you have a valid license, you have the right to
use a single Licensed Copy of Lepide.
Scope of License
Each Licensed Copy of Kernel for SQL Database may either be used by a single person or used nonsimultaneously by multiple people who use the software personally installed on a single workstation. All
rights of any kind in the Lepide, which are not expressly granted in this License, are entirely and
exclusively reserved to and by Lepide Software. You may not rent, lease, modify, translate, reverse
engineer, decompile, disassemble, or create derivative works based on, Lepide, nor permit anyone else
to do so. You may not make access to Lepide available to others in connection with a service bureau,
application service provider, or similar business, nor permit anyone else to do so.
Warranty Disclaimers and Liability Limitations
Kernel for SQL Database, and any and all accompanying software, files, data and materials, are
distributed and provided as is and with no warranties of any kind, whether expressed or implied. In
particular, there is no warranty for the quality of data recovered. You acknowledge that good data
processing procedure dictates that any program, including Kernel for SQL Database, must be thoroughly
tested with non-critical data before there is any reliance on it, and you hereby assume the entire risk of all
use of the copies of Kernel for SQL Database covered by this License. This disclaimer of warranty
constitutes an essential part of this License. In addition, in no event does Lepide Software authorize you
or anyone else to use Kernel for SQL Database in applications or systems where Kernel for SQL
Database Failure to perform can reasonably be expected to result in a significant physical injury, or in
loss of life. Any such use is entirely at your own risk, and you agree to hold Lepide Software harmless
from any and all claims or losses relating to such unauthorized use.
General
This License is the complete statement of the agreement between the parties on the subject matter, and
merges and supersedes all other or prior understandings, purchase orders, agreements, and
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and
you consent to such jurisdiction and venue. There are no third-party beneficiaries of any promises,
obligations, or representations made by Lepide Software herein. Any waiver by Lepide Software of any
violation of this License by you shall not constitute, nor contribute to, a waiver by Lepide Software of any
other or future violation of the same provision, or any other provision, of this License.
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